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 Copyright © 2002 by Canon, Inc. All rights reserved. The unauthorized transfer of all or
any part of the contents of this manual is forbidden.
 The contents of this manual are subject to change without notice.
 Every effort has been made to ensure that content of this manual is free from errors.
If you encounter any errors, omissions or apparent inaccuracies, contact the
manufacturer.

 Notwithstanding  above, the manufacturer accepts no liability whatsoever arising from
the results of using this product.

This manual describes how to use the WebView Livescope Ver. 3.20 Viewer software.
The two types of viewer are Java viewers and the Helper Viewer, and the video sender
can use one or the other as required. Both types provide the same basic functions for
viewing videos, but differ in terms of other features and functions. The preparations for
using the two viewer types and the required operating environment also differ
depending on the computer hardware and software used to run the viewer.
Read this manual carefully before you use the viewer to ensure that you make the best
possible use of this product.
Store this manual in a safe place after you finish reading it.

Important

Introduction

Trademark Information

Canon and Canon logo are registered trademarks of Canon Inc.

Microsoft Windows, Windows NT, and Microsoft Internet Explorer are registered trademarks of the Microsoft

Corporation in the United States and other countries.

Netscape is a trademark of Netscape Communications Corporation.

All other company or product names used in this document are trademarks or registered trademarks of their

respective holders.

* In this manual, "Microsoft Windows" is abbreviated as simply "Windows".

Conventions

Indicates important notes or restrictions that must be observed when using this product. Always

read these notes.

Indicates additional information or explanations for a procedure. You should read these items.

Copyright Information

Under copyright law, video or still images photographed by the client cannot be used for any purpose other than

personal enjoyment without prior permission from the copyright holder

c
Note

e
Tip
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Overview

� WebView Livescope is the system that allows camera control and live video distribution from a

remote location.

� The system is configured of a camera server and viewer software. The camera server distributes

live videos taken by the video camera to the Internet or an Intranet. The viewer software can

display those videos and remotely control the camera.

� The WebView Livescope system can be used in a wide range of applications such as distributing

live videos from a Web site and monitoring.

The following types of camera servers are available:

• Network Camera Server VB101

• Network Camera VB-C10/VB-C10R

• WebView Livescope camera server ver. 3.10

The following types of Viewer Software packages are available:

• WebView Livescope viewer software (This manual: provided free of charge with camera

server product)

• WebView Livescope MV ver. 2.0/LE software

WebView Livescope is an video distribution system that enables users to 
actively (by performing operations by oneself) view live (showing now) video 

from Web pages by allowing users to change camera angle and zoom magnification.

Video Sender Live

Active

Video Recipient
(Viewer software)

Sending the current video

Viewing by switching angle and zoom magnification

Offers an easy way 
to provide live information contents.

Offers the advantage of 
being able to actively select desirable 

parts from live video according to 
the user's purposes.

(Camera server)

VB101

VB-C10
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Java Viewer

LiveApplet

Video display functions

Camera control functions

Java Viewer

Glimpse

Video display functions

Java Viewers

Viewer Overview

These are viewers written using Java. These viewers allow the camera server videos to be

viewed on any computer with a Web browser that runs Java, regardless of the platform.

Because the Java applet is downloaded when the viewer starts up, the first video takes

some time to appear, but there is no need to pre-install the viewer on your computer. The

Java Viewer provides two types of viewers: LiveApplet containing Video Display and

Camera Control functions, and Glimpse containing a Video Display function.

Panorama picture

➤

Click

There are two types of WebView Livescope Viewer  Software: the Java Viewer and the Helper

Viewer.
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Helper Viewer

This is a viewer that runs as a helper application. This viewer provides video display and

camera control functions and appears in a separate window at startup. While the Helper

Viewer has to be pre-installed, it offers the advantage of displaying the first video quickly. At

present, only a Windows version of this viewer is available.

c
Note

� There are two types of Helper Viewers: the Helper Viewer that is packaged
with the VB101 network camera server and the VB-C10/VB-C10R network

camera, and the Helper Viewer that can be downloaded at no charge from

the WebView World Web site (see p. 24).

� Panorama pictures must be registered in advance at the camera server.

➤

Click

Panorama picture
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Operating Environment

Java Viewer Ver. 3.20

Web Browser A Web browser that runs Java.

Microsoft Internet Explorer 4.01 or later recommended.

Netscape Navigator or Communicator 4.78 or later

recommended. (excluding 6.01 and 6.1)

Computer
Operating
System

IBM PC/AT Conpatible

Windows 98 Second Edition, Windows Me, Windows NT 4.0

(requires IE 4.01 or later), Windows 2000, Windows XP

Helper Viewer Ver. 3.20

Web Browser A Web browser that runs Java.

Microsoft Internet Explorer 4.01 or later recommended.

Netscape Navigator or Communicator 4.78 or later

recommended.

Computer
Operating
System

IBM PC/AT Conpatible

Windows 98 Second Edition, Windows Me, Windows NT 4.0

(requires IE 4.01 or later), Windows 2000, Windows XP

* This viewer is installed in the camera server and automatically downloads to the client when accessed.

* Operation is unstable when used with an OS or Web browser other than those noted above.

* Must be installed in advance from the CD-ROM supplied with the camera server.



Chapter 1

Java Viewers
This chapter describes the preparations required for using the WebView

Livescope Java viewers and explains how to use the viewers.
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Preparations for Using the Java Viewer

The Java Viewer is automatically downloaded from the camera server. There is no need to install it in

advance. However, depending on the type of Web browser you are using and your software settings,

you must change your Web browser settings.

Using Internet Explorer

Using Netscape Navigator or Communicator

Netscape Navigator and Netscape Communicator also have a setting that specifies

whether the use of Java is permitted.

Select "Preferences" from the "Edit" menu, click "Advanced" and then click in the

"Enable Java" checkbox.

Internet Explorer has a setting that specifies whether the use of Java is permitted.

From the "View" menu, select "Internet Options" and click the "Advanced" tab. Then

set "Java JIT compiler enabled" as the "Java VM" setting.

In Internet Explorer 5 or later, you must install the Java VM.

* For Internet Explorer 4.01

* For Netscape Navigator 6.2

The settings for the Web browser vary depending on the version used. Refer

to the settings given here and check your browser version.
c
Note
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When You are Connected to a LAN

If the camera server is used via an Intranet and you specify the Web browser proxy

setting manually, videos are distributed via the proxy. This can result in a slower

frame rate and proxy server overload.

Use the procedure shown below to set up a "No proxy" connection. Note that if

you are accessing a camera server that is located outside a firewall on the internet,
registration is not required for the camera server.

Using Internet Explorer
From the "View" menu, select "Internet Options" and click the "Connection" tab.

In the "Exception" field, add "Camera server IP address:HTTP conversion

server service port". If there are multiple settings, use a semicolon (;) as the

separator.

Using Netscape Navigator or Communicator
Select "Preferences" from the "Edit" menu and click "Proxies".

In the "No proxy for" setting for "Manual proxy configuration", add "Camera

server IP address:HTTP conversion server service port". If there are multiple

settings, use a comma (,) as the separator.

e
Note

Setup Examples

The settings for the Web browser vary

depending on the version used. Refer to

the settings given here and check your
browser version.

* For Netscape Navigator 6.2

* For Internet Explorer 4.01
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Starting Up the Java Viewer

The Java Viewer is started up from the Web browser that displayed the Web page for distributing

videos.

To create a Web page for distributing videos, refer to Chapter 5 of the User's Manual for the camera

server.

When the "Using Java Viewer"

button in the Web Browser that

displayed the Web page for

distributing videos is clicked, the

Java Viewer starts up and connects

to the camera server.

➤

Click
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Using "LiveApplet"

"LiveApplet" is a viewer with a GUI that allows the user to change the camera angle, zoom ratio and

backlight adjustment settings.

"LiveApplet" Screens

The functions of the GUI displayed on the Web browser are briefly described below.

1

2

3

4

5

Reduce resolution button and Increase resolution button

The right-hand button makes the displayed video source one level smoother, while

the left-hand button makes it one level coarser. Making the image coarser increases

the frame rate, while making it smoother improves the video quality.
* Depending on the camera server, the video source size change button is occasionally not dis-

played.

Camera selection bar

When multiple cameras are installed on the camera server, this bar can be used to

select the camera.

Tilt scroll bar

Used to change the camera tilt angle (up and down movement)

Zoom scroll bar

Used to change the zoom ratio.

Moving the button up zooms in (telephoto) and moving it down zooms out (wide-

angle).

Panorama view button

Displays the pop-up panorama window. Panorama pictures must be saved at the

camera server. Panorama pictures will not be displayed if not saved.

1

2

3

4

5

67891011
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6

7

8

9

10

11

Camera control status window

Used to display camera control information ("Camera controllable", "Camera not

controllable", "Awaiting turn", "Remaining camera control time").

Start control button

Used to acquire camera control privileges.

Backlight adjustment button

Compensates for backlighting. Useful when the video appears dark due to

backlighting. Click the button again to cancel.

Presets

Allows you to control the camera by selecting preset camera positions registered

beforehand on the camera server.

Pan scroll bar

Used to change the camera pan angle (left and right movement).

Snapshot button

Shows a snapshot of the currently displayed video frame in a separate window. The

snapshot image can then be printed or saved.

Panorama Window

You can control the camera by clicking in the panorama window or dragging the yellow

frame on the panorama window.

The black frame indicates the range of

movement for the camera center. The

camera center cannot be moved outside

this frame.

The blue frame indicates the area currently being photographed by the camera.

When you are granted control privileges, this changes to a yellow frame. You can

control the camera pan and tilt by dragging this frame and control the camera

zoom by resizing this frame.

The size of the panorama window may differ from that shown above if field of

view restrictions have been specified on the camera server.c
Note
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Starting Camera Control

Although multiple clients can simultaneously connect to the camera server, multiple clients
cannot simultaneously control the camera. Consequently, "control privileges" has been
introduced by which only the client who currently holds the control privileges can control the
camera. Backlight adjustment and presets can also only be used when you have control
privileges.

Procedure

Camera control status window
Shows the camera control status.

� Camera Control Status Displays
The display changes depending on the camera control status.

Camera is not controlled.

You have clicked the
[Start control] button and
the camera server is
being contacted. This

display does not appear if the
camera server responds
immediately.

Awaiting control privilege
reservation. The number
beside the person icon
shows the estimated time

until control privileges are granted.
However, you may be granted
control privileges before this
number reaches "0" because other
users may cancel camera control or
withdraw from the queue.

1

2

3

4

5

6

Click the [Start control] button to acquire control privileges.

You have been granted
control privileges. The
number beside the clock
icon is your period of
exclusive control.

You can retain control
privileges even though
your period of exclusive
control has expired. This

is because there are no camera
control requests from other clients.

For some reason, you
have been disconnected
from the camera control
server, you could not

connect to the camera control
server at startup, or your connection
was not permitted. The status
display panel turns red.

Using "LiveApplet"
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Procedure

Controlling the Camera

Once you have been granted camera control privileges, you have complete control over the

camera angle, the zoom ratio and the backlight adjustment setting.

Changing the Camera Angle

Move the button on the pan scroll bar or tilt scroll bar.

The camera angle changes to match the position of the scroll bar buttons.

Tilt scroll bar

This scroll bar changes the camera's

tilt (up or down).

Pan scroll bar

This scroll bar changes the camera's pan (left or right).

� Changing the Camera Angle in the Panorama Window

By clicking

When you click in the panorama window, the camera pans and tilts so that the place

you clicked is in the center.

By dragging

When you drag inside the yellow frame in the panorama window to another position,

the camera pans and tilts so that it is photographing the area in the frame.

By clicking a point on the video,
you can move the center of the
camera to that point.
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Using "LiveApplet"

Procedure

Changing the Camera Zoom Ratio

Move the scroll bar button up or down.

The camera zooms in or out to match the position of the zoom bar button.

Zoom scroll bar

Move the button up to zoom in

(telephoto)

Move the button down to zoom out

(wide-angle)

� Changing the Zoom Ratio in the Panorama Window

By dragging

When you drag the edge of yellow frame in the panorama window to change the frame

size, the zoom ratio changes accordingly.

If you click outside the frame and drag the mouse while holding the button

down, a blue frame is drawn. When you release the mouse button, the blue

frame turns yellow and the camera pans, tilts and zooms to shoot the area in

the new frame.

e
Tip
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Procedure

Selecting the Camera

When multiple cameras are installed on the camera server, you can switch between

cameras. Click in the Camera selection bar to view the list of cameras. When you select a

camera from the list of names, the display changes to show the video from that camera.

Camera selection bar

Procedure

Using Presets

You can control the camera by selecting preset camera positions (presets) registered on the

camera server.

Click in the Presets selection bar to view the list of preset positions. When you select a

preset position from the list, the display changes to show the video from that position.

Preset selection bar

The presets and camera selection options displayed are those set on the

camera server. If no presets or additional cameras are registered on the

camera server, no selection options are shown.

c
Note
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Using "LiveApplet"

Procedure

Adjustment of Backlight

Backlight adjustment is useful when the video is dark due to backlighting.

When you click the [Backlight adjustment] button, video darkened by backlighting become

brighter.

Click the button again to cancel.

Backlight adjustment

button
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Printing and Saving Still Pictures
The Java viewers do not have functions for printing or saving the video
displayed.

However, you can use the Snapshot function to save and print video as still

picture.

 Take a snapshot of the video you want to print or save.

 Use the Save or Print function in your web browser to save or print the still
picture.

Procedure

Taking a Snapshot of the Video

This function allows you to take a snapshot (still picture) of a particular live video.

When you take snapshot, it appears in a new window of your browser.

Because a new still picture is captured when you click the camera icon, the

still picture displayed may be fractionally later than the moment you clicked
the icon.

Under copyright law, video or still pictures photographed by the viewer

cannot be used for any purpose other than personal enjoyment without prior

permission from the copyright holder

When you click on the camera

icon, the still picture at the time

you took the snapshot appears in

a new window.

c
Note

e
Tip

c
Note
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Using "LiveApplet"

Customizing the Viewer Screen
The function buttons and other aspects displayed in the Java Viewer can be
customized according to camera server settings. Functions restricted by the

camera server can be customized so that they are not displayed, or they may

be made to be displayed in a different way according to the setting.

For details, refer to the User's Manual of the camera server.

c
Note
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Using "Glimpse"

The "Glimpse" viewer is a light-weight Java viewer. It has a short download time as it has no camera

control functions and only displays video images.

This viewer is useful for viewing videos from multiple sites, as shown below..

"Glimpse" Screen

The Glimpse viewer is used only for viewing videos; it does not include camera control

functions.



Chapter 2

Helper Viewer
This chapter describes the preparations required for using the WebView

Livescope Helper Viewer and explains how to use the viewer.
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Procedure

Preparations for Using the Helper Viewer

Installing the Helper Viewer

Unlike the Java viewers, the client must pre-install the Helper Viewer on his or her computer.

Difference between 2 Helper Viewers

There are two types of Helper Viewers: the Helper Viewer that is packaged with the

Network Camera Server VB101 and the Network Camera VB-C10/VB-C10R, and the

Helper Viewer that can be downloaded at no charge from the WebView World Web site.

Hereafter, they were will be referred to as the "VB Package Version" and the "Download

Version". The "VB Package Version" includes all the functions of the "Download Version".

Please use the VB Package Version when you have purchased the camera server.

The explanations in this manual center on the VB Package Version. Functions that are

possible only with the VB Package Version are indicated by  VB Package Version only  .

1 For the VB Package Version, load the CD-ROM

supplied with the product into the CD-ROM drive.

Double-click "MonSetup.exe" on the CD-ROM to

start up the installer.

For the Download Version, download the set-up

program from the WebView World Web site (URL:

http://www.canon.com/webview/) and double-click

the program to start up the installer.

Click the Next button.

Functions added in the VB Package Version

� The VB Package Version creates a Shortcut execution file icon on the desktop after it is

installed (see p. 25).

� The VB Package Version can register the IP address, etc., of the camera server.

� The VB Package Version can connect directly to the registered camera site.

Because the WebView Livescope Version 3.20 Helper Viewer uses ActiveX

control, Microsoft Internet Explorer 4.01 or later must be installed. Check that

Microsoft Internet Explorer 4.01 or later is already installed before installing

the Helper Viewer.

c
Note
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2 Specify the folder where the Viewer is to be

installed and click Next.

If no folder specification is required, simply click

Next.

3 Specify the menu name to be registered in the

Program menu of the Start menu, then click Next.

4 Check the settings and selections thus far and

click Next to confirm. Make the file copy and

registry settings, etc., then install.

5 Click Finish to complete the installation. A shortcut

icon is created on the Desktop.

 VB Package Version only

� If the Helper Viewer of WebView Livescope ver. 3.10 or earlier is already

installed, when you try to install the new version, a dialog box appears
asking you if you want to uninstall the old version. If you want to reinstall,

click Yes, and the new version will be installed after the installer uninstalls

the currently installed Helper Viewer.

� Two types of WebView Livescope Helper Viewers cannot be installed in the

same machine.

� It cannot be installed in a machine in which WebView Livescope MV ver. 1.0
has been installed.

c
Note
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Using Browsers Other Than the Recommended Products

To launch and run the Helper Viewer from a Web browser, the recommended browsers are:

Microsoft Internet Explorer 4.01 or later, and

Netscape Navigator or Communicator 4.78 or later.

The use of any browser other than these may require some setup measures. If you cannot

launch the viewer after installation, launch the Web browser and register the Helper Viewer

as a helper application. For information on registering helper applications, refer to the

documentation provided with your browser.

MIME type x-webview-h

Extension wvh

Application

C:\Program Files\Canon\WebView\Viewer\3.2 (default installation

folder)

MonView.exe (For Download Version, it is WebView.exe)

The application "MonView.exe" or "WebView.exe" is installed into

the folder specified for the installation.

Preparations for Using the Helper Viewer
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Starting Up Helper Viewer

The Helper Viewer can be started up in two ways: From the Web browser that displayed the Web

site for distributing videos, or starting it up independently. Normally it is started up from the Web

browser.

To create a Web page for distributing videos, refer to Chapter 5 of the User's Manual for the camera

server.

Starting Up from the Web Browser

Click the "Using Helper" or other

button on the Web browser that

displayed the Web site for

distributing videos . The Helper

Viewer starts up and connects to the

camera server.

➤

Click

Starting Up Independently

With the VB Package Version,

double-click the icon created on the

Desktop. With the Download

Version, double-click c:/

ProgramFiles/Canon/WebView/

Viewer/3.2/WebView.exe. It can also

be started up by choosing it from the

Start menu: Start | Program |

WebView Livescope | Helper Viewer.

No connection to the camera server

is made when the Helper Viewer is

started up independently.

➤

Double-click
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Connecting to a Camera Server

When you use the Helper Viewer to connect to a camera server and monitor, if the Helper Viewer

was started up from the Web browser, it automatically connects to the camera server, but if the

Helper Viewer was started up independently, you need to specify a connection target or select a

registered connection target.

You can also change the connection target to another camera server while you are still connected to

one camera server, or start up multiple Helper Viewers and connect each one to a different camera

server.

Specifying a Connection Target and Connecting

Procedure

1 Choose Connect from the File menu.

2 A dialog box for specifying a connection target

appears. Enter each item and click OK to make a

connection to the camera server.

� Host Name
Specify the IP address of the camera server.

� Port No.
Specify the port numbers. of the camera server. They are the values that were
specified on the camera server. Normally they can be used with the default setting.

� Relay Server
If you are not connecting to a relay server, select "Not Used"; if you are connecting to
a relay server, select the registered name of the relay server. Normally, leave "Not
Used" selected (see p. 48).

� Protocol
Select whether to connect to the camera server using auto select or to connect using
the WebView-TCP or WebView-HTTP protocol. In connections using auto select, the
viewer automatically selects the optimum protocol and connects to the camera server.
If you are connecting to the camera server from inside the firewall, select WebView-
HTTP (see pp. 42, 43).

� Add to camera site
When this is selected, camera server information that was entered above is registered
into the viewer, and you can view videos by simply selecting them from the selection
box (see p. 29).

VB Package Version only
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Selecting a Registered Camera Server and Connecting

Procedure

Select the connection target from the site selection

box. The camera servers displayed here are sites that

were registered by selecting "Add to camera site list

(see p. 28)" when a connection was made by

specifying a connection target, or registered using the

"Register connected site button (see p. 38)".

See p. 46 for details on registering or changing a

server.

Disconnecting

Procedure

Choose Disconnect from the File menu, or close the

Viewer window, to exit.

VB Package Version only

VB Package Version only

c
Note

You connect to a site containing user access restrictions, you will be asked to

enter a user name and a password. Enter the correct user name and

password to complete the connection. (Refer to the User's Manual of the

camera server.)
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Using the Helper Viewer

The Helper Viewer provides a GUI that allows you to change the camera angle, zoom ratio and

backlight adjustment settings.

"Helper Viewer" Screens

The functions of the GUI displayed when the helper viewer starts up are briefly described below.

1

2

3

4

5

Reduce resolution button and Increase resolution button

The right-hand button makes the displayed video source one level smoother, while

the left-hand button makes it one level coarser. Making the image coarser increases

the frame rate, while making it smoother improves the video quality.

Full screen mode button

Displays the video at full-screen size. Press the [Esc] key to return to the original

video size.

Pause/Restart button

Pauses moving pictures during play, or starts play if currently stopped.

Register connected site button

Lets you register a camera site during connection.

Site Selection dialog box

Lets you connect to a registered camera site by selecting it here.

Camera selection bar

Can be used to select the camera when multiple cameras are installed on the camera

server.

Tilt scroll bar

Used to change the camera tilt angle (up and down movement)

1 2 3

6

7

8

9

10

11121314

6

4

5 VB Package Version only

7

VB Package Version only

VB Package Version only

VB Package Version only



H
elper V

iew
er

2

31

9

10

11

12

13

14

Zoom scroll bar

Used to change the zoom ratio.

Moving the button up zooms in (telephoto) and moving it down zooms out (wide-

angle).

Panorama view button

Displays the pop-up panorama window. Panorama pictures must be saved at the

camera server. Panorama pictures will not be displayed if not saved.

Camera control status window

Used to display camera control information ("Camera controllable", "Camera not

controllable", "Awaiting turn", "Remaining camera control time").

Start Control button

Used to acquire camera control privileges.

Backlight adjustment button

Compensates for backlighting. Useful when the video appears dark due to

backlighting. Click the button again to cancel.

Presets

Allows you to control the camera by selecting preset camera positions registered

beforehand on the camera server.

Pan scroll bar

Used to change the camera pan angle (left and right movement).

Panorama Window

You can control the camera by clicking in the panorama window or dragging the yellow

frame on the panorama window.

The black frame indicates the range of

movement for the camera center. The

camera center cannot be moved outside

this frame.

The blue frame indicates the area currently being photographed by the camera
when you do not hold camera control privileges.
When you are granted control privileges, this changes to a yellow frame. This
frame not only indicates the area being photographed by the camera, but you can
also control the camera pan and tilt by dragging the entire frame around and
control the camera zoom by dragging the edge of the frame to change its size.

c
Note

The size of the panorama window may differ from that shown above if field of
view restrictions have been specified on the camera server.

8
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Starting Camera Control

Although multiple clients can simultaneously connect to the camera server, multiple clients
cannot simultaneously control the camera. Consequently, "control privileges" has been
introduced by which only the client who currently holds the control privileges can control the
camera. The use of backlight adjustment and presets is also limited to the client who
currently holds the control privileges.

Procedure

Camera control status window
Shows the camera control status.

� Camera Control Status Displays
The display changes depending on the camera control status.

Camera is not controlled.

Awaiting control privilege
reservation. The number
beside the person icon
shows the estimated time

until control privileges are granted.
However, you may be granted
control privileges before this number
reaches "0" because other users
may cancel camera control or
withdraw from the queue.

You have been granted
control privileges. The
number beside the clock
icon is your period of

exclusive control.

1

2

3

4

5

Click the [Start Control] button to acquire control privileges.

You can retain control
privileges even though
your period of exclusive
control has expired. This

is because there are no camera
control requests from other clients.

For some reason, you
have been disconnected
from the camera control
server, you could not

connect to the camera control server
at startup, or your connection was
not permitted. The status display
panel turns red.
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Using the Helper Viewer

Procedure

Controlling the Camera

Once you have been granted camera control privileges, you have complete control over the

camera angle, the zoom ratio and the backlight compensation setting.

Changing the Camera Angle

Move the button on the pan scroll bar or tilt scroll bar.
The camera angle changes to match the position of the scroll bar buttons.
Also, if you click a point on the image, the camera moves so that the point you clicked

becomes the center of the video.

By clicking a point on the video,
you can move the center of the
camera to that point.

Tilt scroll bar

This scroll bar changes the camera's

tilt (up or down).

Pan scroll bar

This scroll bar changes the camera's

pan (left or right).

� Changing the Camera Angle in the Panorama Window

By clicking

When you click in the panorama window, the camera pans and tilts so that the place

you clicked is in the center.

By dragging

When you drag inside the yellow frame in the panorama window to another position,

the camera pans and tilts so that it is photographing the area in the frame.
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Procedure

Changing the Camera Zoom Ratio

Move the scroll bar button up or down.

The camera zooms in or out to match the position of the zoom bar button.

Zoom scroll bar

Move the button up to zoom in (telephoto)

Move the button down to zoom out (wide-

angle)

� Changing the Zoom Ratio in the Panorama Window

By dragging

When you drag the edge of yellow frame in the panorama window to change the frame

size, the zoom ratio changes accordingly.

If you click outside the frame and drag the mouse while holding the button

down, a blue frame is drawn. When you release the mouse button, the blue

frame turns yellow and the camera pans, tilts and zooms to shoot the area in
the new frame.

e
Tip
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Using the Helper Viewer

c
Note

Procedure

Selecting the Camera

When multiple cameras are installed on the camera server, you can switch between

cameras. Click in the Camera selection bar to view the list of cameras. When you select a

camera from the list of names, the display changes to show the video from that camera.

Camera selection bar

Procedure

Using Presets

You can control the camera by selecting preset camera positions (presets) registered on the

camera server.

Click in the Presets selection bar to view the list of preset positions. When you select a

preset position from the list, the display changes to show the video from that position.

Preset selection bar

The presets and camera selection options displayed are those set on the
camera server. If no presets or additional cameras are registered on the

camera server, no selection options are shown.
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Procedure

Changing the Video Source Size

If multiple video source sizes are specified on the camera server, these buttons can be used to
select the size used for display. Changing the video source size does not change the size of the

video displayed.
* The effects of the Picture Source Size Change button may not be reflected in all camera servers.

Procedure

Using Full-Screen Mode

You can use this function to view the video displayed at full-screen size. If you click the [Full-

screen mode] button and then click [OK] in the confirmation dialog box that appears, the video
appears at full-screen size. To revert to the
original video size, press the [Esc] key. If you

click the right mouse button in while in full-
screen mode, a
pop-up menu

appears from which

you can choose to

return to the

original video size

Makes the video source one level coarser (faster frame rate)

Makes the video source one level smoother (better video quality)

or pop up the

panorama window

on the current

video.
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Using the Helper Viewer

Procedure

Adjustment of Backlight

Backlight adjustment is useful when the video is dark due to backlighting.

When you click the [Backlight adjustment] button, videos darkened by backlighting become

brighter.

Click the button again to cancel.

Backlight adjustment button

Procedure

Stopping and Restarting Video Display

Moving picture displays can be stopped or restarted. Click the Pause/Restart button. Moving picture

displays can also be stopped on the menu that is displayed when you right click the mouse on the

picture screen. To resume, right click the mouse

and select "Resume Paused Picture" .

"Pause Picture Display" to stop video display

and "Resume Paused Picture" to restart the

stopped video display.
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Menu-based Operations

All the functions accessed via buttons can also be accessed from the menu
bar. Functions that can only be accessed from the menu bar are discussed on

the following pages.

* See p. 46 for details on using the Camera Sites list and the Relay

Servers list.

Procedure

Registering a camera site during connection

By registering a camera site during connection, subsequent connections to that site become

easy. The camera site currently connected can be registered by clicking the "Register

connected site" button. Registered camera

sites are displayed in the Site Selection

dialog box and can be connected to by

simply selecting them. Registered camera

sites can also be changed or deleted (see p.

47).

VB Package Version only

e
Tip



H
elper V

iew
er

2

39

Using the Helper Viewer

e
Tip

Procedure

Saving Still Pictures to Files

When the video you want to save appears, click the "Pause/Restart" button.

The video is displayed as a still picture.

Select "Save" from the "File" menu.

When it ends, the moving picture display resumes when you click the "Pause/Restart" button.

Procedure

Saving and Printing Still Pictures

You can save and print snapshots of live video you want to retain.

1

2

1

2

3

Saved File Formats
Files are saved in JPEG format.

Saved still pictures can be viewed using a Web browser or image display software.

Printing Still Pictures

When the video you want to print appears, click the "Pause/Restart" button.

The video is displayed as a still image.

Select "Print" from the "File" menu.

Specify the print settings.
To change the printer settings, click the
[Setup] button.
When you have finished printing, click the "Pause/Restart" button to restart video
display.

Setting Details

Print position Specifies the print position for the image.

Print camera 
information

Ticking this checkbox prints camera parameters such as the pan and 
tilt angles with the image.

c
Note

Under copyright law, video or still pictures photographed by the viewer

cannot be used for any purpose other than personal enjoyment without prior
permission from the copyright holder
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Using the Helper Viewer

Displaying Information
Dialog boxes can be displayed that show the video, connection and camera information. To view
this information, select "Video information", "Connect Information" or "Camera Information" from
the "View" menu.

Video Information

� Frame rate
Received frame rate

� Size
Data capacity per frame

� Captured image size
Height and width of the video data being
received

� Compression type
Server's video compression method

Connection Information

� Protocol

WebView-TCP or WebView-HTTP

� Video [WV-TCP]

IP address of camera server:port number

� Camera control [WV-TCP]

IP address of camera server:port number

� Video/Camera [WV-HTTP]

IP address of camera server:port number

� Relay server

IP address of relay server; Port No. of

video, camera control, and HTTP

� Proxy

Proxy usage information

� Local time

Local time on the camera server (GMT)

Camera Information

� Pan
Current camera pan angle

� Tilt
Current camera tilt angle

� Zoom
Current camera zoom (viewing angle) value

� BackLightMode
Current backlight adjustment ON/OFF
status

� CameraModel
Model of the camera



Chapter 3

Helper Viewer Settings
This chapter describes how to specify the software environment settings for

the WebView Livescope Ver. 3.20 Helper Viewer.
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Procedure

Specifying the "Starting protocol" Setting

Select "Setup properties" from the "View" menu.

Select "Protocol for starting with WVH file" in "Starting protocol" tab.

Helper Viewer Settings

From the "Setup property" window, you can specify a range of settings governing the operation of the

helper viewer. Normally, there is no need to alter these settings.

1

2

Specify whether connection to the camera server is to be made using the WebView-TCP

protocol or the WebView-HTTP protocol.

� "Auto select connection"
Use this setting when you do not know
the details of the connection
environment. When this option is
selected, the viewer first tries to connect
using WebView-TCP and then tries
WebView-HTTP.

� "WV-TCP protocol connection"
This setting uses the WebView-TCP
protocol used specifically by WebView
for TCP connections. To penetrate
firewalls with this protocol, a dedicated
application gateway is required.

Viewing videos from behind a firewall
To view videos from behind a firewall using the WebView-HTTP protocol, you
must specify the HTTP proxy settings. You can set the same settings as the
HTTP proxy specified in your Web browser. If you want to access videos from
behind a firewall, this is normally specified here. (See P.43 for details.)

� "WV-HTTP protocol connection"

This setting uses the WebView-HTTP protocol, which is the WebView protocol that conforms

to the ordinary HTTP standard. The HTTP proxy can be used as is and the firewall can be

passed.

c
Note
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Procedure

"HTTP protocol" Settings

Select "Setup properties" from the "View" menu and then select the "HTTP protocol"

tab.
1

2

Specify these settings when you are connecting using the WebView-HTTP protocol.

 Ticking the "Use WV-HTTP proxy"

checkbox allows you to use a

proxy that uses HTTP. This then

allows you to penetrate firewalls.

 In "WV-HTTP proxy server",
specify the host name and port

number of the server to be used.

 If you have ticked the "Use WV-

HTTP proxy" option in  above,

ticking the "Do not use the proxy

for local hosts" checkbox allows

you to connect to local addresses

without using the proxy.

You can use asterisks (*) as wildcards in the host name in the "Set hosts not

using proxy." setting. This allows you to specify multiple host names at once.

(Example)
192.168.100.*

Hosts with an IP address that begins with "192.168.100." do not use the proxy.

*.webview.co.jp

Hosts on the network with the "webview.co.jp" domain name do not use the

proxy.

 The "Set hosts not using proxy." option allows you to access servers that do not

require proxies without using the proxy. Enter the domain name or IP address of the

host that does not use proxies. To specify multiple hosts, use a comma to separate

the specifications.

e
Tip
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Procedure

"Performance" Setting

Select "Setup properties" from the "View" menu and then select the "Performance" tab.

Select "WV-TCP protocol option".

1

2

You can use the WV-TCP protocol high-speed TCP mode to achieve faster video frame

rates.
* The effects of the "Faster" setting may not be reflected in all camera servers.

� "Camera control"

Uses the normal WV-TCP protocol.

� "Video rate"

Uses the WV-TCP high-speed protocol. The level of improvement depends on the

circumstances, but the frame rate in this mode is generally 10% to 40% faster than

when the "Camera control" option is selected. However, camera control responses

may be slower.

The frame rate may not improve due to network traffic or other factors.c
Note
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Helper Viewer Settings

Procedure

"Display option" Setting

Select "Setup properties" from the "View" menu and then select "Display option".

Select "Set video display size used at startup".

1

2

Use this setting to specify the size of the video displayed at startup. Note that the opening

screen shown at startup is displayed at an image size of 320x240.

� "Adjust to default image size"

When you connect to the server, the viewer starts up with the image size matched

to the image size initially sent.

� "Use a display size in list below"

Allows you to select any of 4 sizes: 640×480, 320×240, 160×120 or 80×60.
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Registering and Changing the Server

The VB Package Version lets you register the camera server and relay server and thereafter you can

connect simply by selecting a registered server. Here we explain how to change the registration of

the camera site and relay server.

Procedure

Adding to a list

A camera server can be registered during connection by clicking the "Register connected

site" button or choosing "Register Site" in the File menu. If the site is currently not

connected, it can be registered following the procedure below:

Choose "Camera Site List" from the View

menu. When the camera site list appears,

click Add.

� Nickname
Any name can be given to the camera server being registered.

� Host Name
Specify the IP address of the camera server.

� Port No.
Specify the Port numbers of each camera server. The port numbers are the values
that were set on the camera server.

� Relay Server
If connections to the camera site being registered is not to be made via a relay
server, select "Not Used"; if a relay server is to be used, select the registered name
of the relay server (see p. 48).

Enter each item and click OK. The site is

added to the list.

1

2

Registering in a Camera Site List

VB Package Version only
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� Protocol
Select whether to connect to the camera server using auto select or to connect using
the WebView-TCP or WebView-HTTP protocol. In connections using auto select, the
viewer automatically selects the optimum protocol and connects to the camera server.
If you are connecting to the camera server from inside the firewall, select WebView-
HTTP (see pp. 42, 43).

Procedure

Changing or deleting registration details in the list

Choose "Camera Site List" from the View

menu, and select the registered camera site

that you want to change or delete.

If you want to make changes in the details,

click Edit. To delete a site, click Delete.

If you are changing details, make the

changes and click OK.

If you are deleting a site, the selected site is

deleted.

1

2

While a camera site is selected, you can

move it to a different position in the list by

clicking the Up or Down button. This order is

reflected in the list displayed in the Site

Selection dialog box.

3
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Procedure

Adding a relay server to the list

Choose Relay Server List from the View

menu. When the relay server list appears,

click Add.

Enter each item and click OK. The relay

server is added to the list.

1

2

� Relay Name

Any name can be given to the relay server being registered.

� Host Name

Specify the IP address of the relay server.

� Port No.

Specify the Port numbers of each camera server. The port numbers are the values

that were set on the camera server.

� Set the camera using the relay server

If the relay server is to be used in connections established by selecting a camera

site, you can specify the camera site that can be connected via a registered relay

server.

Registering in the Relay Server List
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Registering and Changing the Server

Procedure

Changing or deleting registration details in the list

Choose Relay Server List from the View

menu, and select the registered relay

server that you want to change or delete.

If you want to make changes in the

details, click Edit. To delete the server,

click Delete.

If you are changing details, make the

changes and click OK.

If you are deleting a relay server, the

selected server is deleted.

1

2

While a relay server is selected, you can

move it to a different position in the list by

clicking the Up or Down button. This order

is reflected in the list displayed in the

connection dialog box.

3
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Appendix
Messages displayed in the viewers are explained in this section.
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Error Messages

Message

Details

Solution

too many clients

The limit on the number of video server connections has been exceeded.

Access to the camera server is apparently overcrowded. 
Wait some time and then reconnect.

Situation At connection

Message

Details

Solution

can't connect
version mismatched

The camera server is a different version.

Clear the Web browser cache.

Situation At connection

Message

Details

Solution

failed to connect to the camera control server.

The viewer cannot connect to the camera server.

There is a coding error in the Web page used for video distribution, 
or there is a problem on the camera server. Check with the administrator of the video 
distribution Web page.

Situation At connection

Java Viewer Error Messages

Message

Details

Solution

couldn't get camera control

The limit on the number of people queuing for camera control privileges has been 
exceeded.

Access to the camera server is apparently overcrowded. Wait some time and then 
try again to acquire control privileges.

Situation During camera control privileges acquisition

Message

Details

Solution

camera control is disabled

The viewer cannot connect to the camera control server.

This is normal operation because camera control is prohibited by the camera server.

Situation At connection
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Helper Viewer Error Messages

Message

Details

Solution

No response from video server.

The viewer could not connect to the video server.

There is a coding error in the Web page used for video distribution, or there is a 
problem on the camera server. Check with the administrator of the camera server.

Situation At connection

Message

Details

Solution

Network is busy. Please try again later.

The limit on the number of video server connections has been exceeded.

Access to the camera server is apparently overcrowded. Wait some time and then 
try again to acquire control privileges.

Situation At connection

Message

Details

Solution

No response from camera control server. You can use video only.

The viewer could not connect to the camera control server.

This is normal operation because camera control is prohibited by the camera server.

Situation At connection

Message

Details

Solution

camera is off-line or abnormal

The connected camera is switched off or the RS cable is not connected.

There is a problem with the camera server (with the camera power supply or the 
RS cable connection). Check with the administrator of the camera server.

Situation At connection

Message

Details

Solution

disconnected

The connection time limit has expired or the connection was cut due to restart 
processing on the camera server.

To reconnect, reload (refresh) the Web page in your Web browser.

Situation At connection
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Error Messages

Message

Details

Solution

Couldn’t get camera control privileges.

The limit on the number of people queuing for camera control privileges has been 
exceeded.

Access to the camera server is apparently overcrowded. 
Wait some time and then reconnect.

Situation At connection

Message

Details

Solution

You do not have video server access privileges.

There is a restriction applied in the camera server settings that limits the IP 
addresses of clients allowed to connect.

This is normal operation. This situation is set up by the camera server administrator.

Situation At connection

Message

Details

Solution

Camera switched off or faulty.

The connected camera is switched off or the RS cable is not connected.

There is a problem with the camera server (with the camera power supply or RS 
cable connection).

Situation At connection

Message

Details

Solution

Invalid WVH file.

There was an error in the information in the WVH file.

There is a coding error (WVH file) in the Web page used for video distribution, or there 
is a problem on the camera server. Check with the administrator of the web page.

Situation At connection

Message

Details

Solution

Disconnected

The connection time has expired or the connection was cut due to restart processing on 
the camera server.

Restart your Helper Viewer.

Situation At disconnection
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